
REF

Transitions
REFERENCE



   

2

Copyright and Trademark

Please read the license agreement in the ’Getting Started’ booklet
carefully. Subject to technical alteration.

All rights reserved. Subject to change without notice.
Release 4700; Subject to technical alteration.

Printed in Germany

AIST - Animated Image Systems Technology GmbH
Mobil-Oil-Str. 31
84539 Ampfing
Germany
Tel.: ++49 (86 36) 98 35 0
Fax: ++49 (86 36) 98 35 22
Internet: http://www.aist.com (English)
Internet: http://www.aist.de (German)
E-mail: info@aist.com
Manual Tutorial Reference Effects
Copyright and Trademark
Reference REF



   
TRANSITIONS

Contents

Transitions .....................................................................................  4

What is a Transition?......................................................................  5

Size.............................................................................  5

Using Transitions ............................................................................  6

Selecting a Transition .....................................................  7

Generated Transition .....................................................  7

Inserting Transitions .......................................................  8

Observing Transitions ....................................................  8

Altering Transitions.........................................................................  9

From Transition to Original Animation............................  10

Creating /Altering Transitions .......................................  10

Fade..........................................................................  11

Creating Complex Transitions .......................................  13

Saving Transitions........................................................  14

Adjusting the Transition Length ......................................  14

Exchanging Objects ....................................................  14

Reversing the Transition Sequence.................................................  15
Contents
Transitions REF 3Manual Tutorial Reference Effects



   

4

Transitions  

Transitions are basically the passage (fade outs/ins) from one video
sequence to another.

Hard cuts from one scene to another are abrupt, lack creativity and are
simply not suitable for some videos. If for example you want to produce
a slideshow, it is defintely more exciting to have the new image flutter
in as the old one crumples up etc. 

The two videos, A and B, of a transition can be customized to suit
individual needs and requirements so that a gradual and appropriate
transition from one sequence to another takes place. 

With MoviePack there are no limits to your creativity. You can choose
from a multitude of ready-to-use transitions, alter them or simply create
your own unique transition.

Ref_Trans_anf001
_G, 002 ... 004_X, 
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What is a Transition?  

A transition consists of two tracks. The objects A and B represent Video
A and Video B which lie above and below the transition track in the
editing tracks. You can manipulate the objects of the transition and
apply effects to them. The finished transition lies in the transition track
of the animation between the video A and B tracks which then behave
as if the manipulations have been applied to them.

I If you want to move from one object to another in an
animation, theoretically you can also edit the original tracks,
for example by gradually minimizing the above lying object
or moving it out of the Canvas. The object lying underneath
will gradually become visible.

However, the advantage of a transition is that it the original object
remains unchanged. Secondly, a successful transition can be used in
other animations. Moreover, you can move, lengthen and shorten the
transition any way you want. 

If you are not happy with the transition you have created simply delete
it and start over using the same video sources.

With MoviePack you do not need a list of hundreds of wipes or other
types of transitions. The standard transitions icon allows you easy
access to a wide range of transitions.

SizeI An image or movie, whether it is moved from a compositing
track or from an Album into an editing track, is automatically
scaled to the size of the Canvas. No manipulations are
transferred into the editing track other than 2D effects, for
example color effects, wipes etc. 

If you want to maintain the manipulations made to the object
you have to save them as an animation before inserting the
object into the editing track and then integrate it into the
transition later.
What is a Transition?
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Using Transitions

Insert an object into the two editing tracks ensuring that they overlap. 

Select a transition. To begin we
are going to use a Generated
Transition. 

Double-click the transition track to open the transition window
(transition mode) where the Timeline contains two compositing tracks. 

In these two special tracks the
transition objects can be
manipulated and altered like any
other object to create a spectacular
and flowing transition. 

The transition is applied to the clip
when switched back to the Canvas
(animation mode).

To switch between transition and
animation mode simply click the
respective winow or use the Window
menu. 

Double-click or drag the transition into the transition track in the
Timeline. 

Generated Transition New Transition
Manual Tutorial Reference Effects
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Selecting a Transition u Click the Transitions icon in the ROOT of the Browser then All
Transitions. Four icons will appear. New Transition contains
empty transitions. Generated Transition contains ready-to-use
transitions. Alpha Wipe and Dissolve are ready-to-use transitions
created using the effect Transparency and act like an effect, i.e.
the transition cannot be opened but their parameters can be
adjusted in the Effect Box.  

Generated TransitionThe Generated Transition icon
opens the desktop where you
can search for pre-made and
saved transitions. MoviePack
contains a folder called
Transitions.  

I You can create your own
transitions using different
effects and then save them or
you can simply download
ready-to-use transitions from the
AIST web site. 
Using Transitions
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Inserting Transitions u You can drag the transition into the desired position of the
transition track or a double-click will insert it behind the
current position of the Timeslider in the transition track. The
transition automatically adapts itself to the size of the
overlapping area between the two videos. 

Observing Transitions After inserting a Generated Transition you can see the result straight away. 

u If necessary use the pointer  to drag the transition to the
desired size. 
Select a preview area using the green preview bar.
Start the Preview and the transition will run. 

Transitions can only be inserted in the middle transition track. 
The video tracks A and B should contain a video and overlap with one another. 

A

B
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Altering Transitions

After inserting a transition the Canvas and Timeline should look something
like this:

Double-click the transition to open a new Canvas window with the name
of the transition and a Timeline, where there are two tracks called Actor1
and Actor2. 

I Actor2, shown by the letter A, represents the clip which lies
above the transition in the main animation. Actor1 = B, the
track beneath the transition. 

Project: 
Ref_Trans003
Ref_Trans003a_X 
und 003b_X
Altering Transitions
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I In the transition mode both objects A and B can be
individually scaled, positioned and have effects applied to
them etc. However you cannot trim, compress or extend
them. 

From Transition to 
Original Animation

u To exit the transition mode simply close the Canvas window of
the transition. 

or

u Click the animation Canvas to activate it. 

or 

u Select the original animation from the Window menu. 

I The transition remains open and if you want to alter it again
simply select the transition from the Window menu.

In the Preview window the preview of the active Canvas window is
shown, either the transition or the animation.

Creating /Altering Transiti-
ons 

If you have selected a new transition or want to alter an existing one:

u Activate Actor2 or Actor1 in the transition mode. In the Effect
Box the transformations are shown as with all objects. The
respective A or B object is displayed in the Canvas. Object A
lies over object B.

u Select any suitable effect from the Browser or select a
transformation to create a transition from A to B.

I You can of course alter Generated Transitions in the same way. 
Manual Tutorial Reference Effects
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Fadeu One of the best loved transitions is a fade. To create a fade
select the effect Transparency from the effect group Image Control. 
Drag the Transparency icon onto Actor2. 
Move the Timeslider to the beginning of the Actor2 track and
set the Transparency in the Effect Box to 0%. 
Now move the Timeslider to the end of the Actor2 track and
set the Transparency in the Effect Box to 100%. 
In the Preview you will see how A turns into B.

u Now activate the animation mode. In the Timeline both the
editing tracks and the transition track are visible. You can
find this transition ready-made under the name
Transparency.

The animation with the transition can now be seen in the Preview. 

Projekt: Ref_Trans_004
Ref_Trans_005_G, 
Ref_Trans004a bis d_X
Altering Transitions
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I If the transition is longer than the object underneath the
background of the Canvas will be visible in the Preview. (here:
Setting: lilac).

You can insert an unlimited number of objects in the tracks one after the
other. 

Transition with no 
underlying object B.

Ref_Trans_006a, Ref_Trans_006b
Ref_Trans_007a, b, c

Several objects have been inserted one after the other in track B and are 
overlapped by a transition. This is why the the underlying object changes during 
the transition. 
Manual Tutorial Reference Effects
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Creating Complex 
Transitions 

Transitions define the effects and their parameters of two special video
layers. Moreover, an unlimited number of tracks can be inserted into the
transition.

u Select an object and drag it onto the transition Canvas. A new
track is created automatically above the track Actor2 (red A).
Manipulate the new object as normal (see the ’Reference -
Canvas’ booklet).

I� Complex transitions allow you to integrate further objects
into a transition (i.e. frame in frame). If the transition time is
altered during editing or if an object is exchanged the
transition and the object contained therein remains constant. 

I If the inserted objects are longer than the A or B tracks, the
Preview of the final animation will show the background of the
transition Canvas.  

In complex transitions the clips or images must be the same length as
the nested objects.
Altering Transitions
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Saving Transitions If you have created a fantastic transition you should save it.

u Double-click the transition track to open the transition mode
(red A track and blue B track appear). From the File menu
select Save as and save the transition. It is automatically given
the extension ’.M3T’.

For temporary storage select an Album.

u Click the Canvas of the transition in the Timeline and drag it into
an Album. 

I If the transition window is open you can also drag individual
objects of the transition into the Album. 

Adjusting the Transition 
Length

A transition can be easily speeded up or slowed down. The transition
objects can be stretched or compressed in length influencing the speed
of the transition. 

Exchanging Objects The sequence of the transition is determined by the order of the A and
B tracks. If you want to run the track from B to A instead of from A to B
select the parameter Exchange A and B sources in the Effect Box. 

Project: Ref_Trans005_G

This switch is visible when the transition 
track is activated and the Timeslider is 
positioned in the transition track. 
Manual Tutorial Reference Effects
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Reversing the Transition Sequence  

To reverse an effect (instead of A getting smaller until it disappears, A
grows) the entire transition does not have be rearranged, simply use the
Timeslider in the Effect Box. 

u Position the Timeslider in the Timeline to the beginning of the
transition.
Set the Time slider in the Effect Box to the end position. 

u Position the Timeslider to the end of the transition.
Set the Time slider in the Effect Box to the starting position.

u To ensure a smooth reverse transition you have to either swap
the objects in the tracks or switch on Exchange A and B Sources.

As you can see below, the bottom transition track has changed from B
to A. The objects have been moved to ensure a smooth transition. 
Reversing the Transition Sequence
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The difference between reversing the transition and changing the object
can be seen in the close-up. 

A = Sphere
B = Spiral

A = Sphere,
B = Spiral

A = Spiral,
B = Sphere

Original

Reverse

Change
Objects
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